Intellisoft

Contents
Preparing to run application
ActiveX controls (OCX)
How to register an ActiveX control (.ocx) manually
Email config
Email send
Troubleshooting
Contents

Preparing to run application
ActiveX controls (OCX)
How to register an ActiveX control (.ocx) manually
Eamil config
eail send
troubleshooting
Preparing to run application
**Windows application requirements:**

- Verify that the login user on this machine has proper rights to access the folder `%drive%:\Program Files\intellicred`
- Verify that the login user on this machine has proper rights to write the register.
- Verify that the User Account Control (UAC) function is off if you use the Vista platform.
Web application requirements:

- Verify that the IE securities are not set too high.
- Verify that the login user on this machine has proper rights to access the folder %drive%\Documents and Settings\%user_name%\Application Data\.
- Verify that the login user on this machine has proper rights to write the register.
- Verify that the User Account Control (UAC) function is off if you use the Vista platform.
Intellisoft/ ActiveX controls (OCX)
Intellisoft/ ActiveX controls (OCX)
ActiveX controls (OCX)
Define

A software component that encapsulates functionality typically provided by an application and makes it available to a client application via properties, functions, and events.
Requirements

Our application that uses some ActiveX controls (.ocx or dll file), the .ocx files must be registered correctly for it to work correctly.
### ActiveX controls (OCX) used in our application

<table>
<thead>
<tr>
<th>Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>officecontrol.ocx</td>
<td>Handle Office (Word, Excel) files.</td>
</tr>
<tr>
<td>emsmtp.dll</td>
<td>Send emails.</td>
</tr>
<tr>
<td>*imageviewer2.ocx</td>
<td><strong>Image Viewer CP ActiveX Control</strong></td>
</tr>
<tr>
<td>*scanner.ocx</td>
<td>Scan images.</td>
</tr>
<tr>
<td>*imgedit.ocx</td>
<td>Edit images.</td>
</tr>
<tr>
<td>*imgscan.ocx</td>
<td>Scan images.</td>
</tr>
<tr>
<td>*imgadmin.ocx</td>
<td>image admin</td>
</tr>
<tr>
<td>*imgthumb.ocx</td>
<td>Image Thumbnail CP ActiveXControl</td>
</tr>
<tr>
<td>*imgocr.ocx</td>
<td>Optical recognition.</td>
</tr>
</tbody>
</table>

Note: * indicates that the OCX is not essential, it depends on image ActiveX
controls (OCX) you purchased.
Intellisoft/ ActiveX controls (OCX) register
Intellisoft/ ActiveX controls (OCX) register
How to register an ActiveX control (.ocx) manually

In realistic runtime environment, there are some unknown factors that would cause ActiveX controls (OCX) to fail to register, hence, cause the Intelli system to malfunction. To enable Intelli system to run correctly, we will have to manually register ActiveX controls (OCX). Below is the detailed description for how to manually register them.

More Information

We can use Microsoft Register Server (Regsvr32.exe) to manually register a 32-bit .ocx file under the 32-bit OS. The syntax of Regsvr32.exe is as below:

Regsvr32 <OCX File Name>

The following example registers the EaseMail ActiveX Control with displaying any messages:

regsvr32 "D:\local workspace\8.5\Scanner.ocx"

Note:
If an error occurs when registering a control, do the following:

1. Verify that the directory and the file name are correct and complete.

2. Verify that the following files are in the Windows\System directory:
   MFC42.DLL
   MSVCRT.DLL
   If one of these files is missing, you may receive the following error message:
   Error: OLE Error Code 0x80040112: Appropriate license for this class not found.
Intellisoft/Email Account Config
Email Account Config
Functionality

Configure the email server and email account.
Preparation

1. Set up the email server and create the email account. Refer to the email server help file for detailed configuration instructions. Test the email server; make sure the SMTP service is enabled and use the other email clients such as Outlook to test the connection.

2. Check the firewall settings; make sure the firewall allows the port of email protocol.

Note: the current Email functionality does not support SSL protocol and SPA Authentication.
How to configure

1. Select menu System -> Personal Setting -> Email Account. The Email Account configuration window is displayed. Specify the SMTP server, Port, Account, Password and Email according to the following explanation.

**Below is a brief explanation of the fields on this window.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server</td>
<td>Server name or IP address of SMTP server</td>
</tr>
<tr>
<td>Port</td>
<td>Port of SMTP server for sending emails</td>
</tr>
<tr>
<td>My SMTP Server Requires Authentication</td>
<td>Determines whether SMTP server needs to validate the login account</td>
</tr>
<tr>
<td>Account</td>
<td>User account, for example, jdamelio</td>
</tr>
<tr>
<td>Set Default Account</td>
<td>If the user has only one email address, then make sure that this option is selected</td>
</tr>
<tr>
<td>Password</td>
<td>Password of user account</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the user, for example, <a href="mailto:jdamelio@intellisoftgroup.com">jdamelio@intellisoftgroup.com</a> (must be the full email address)</td>
</tr>
</tbody>
</table>
For Example:
SMTP Server: pop.onebox.com  
Port: 25  
My SMTP server requires authentication: Unchecked  
Account: thuang  
Set Default Account: Checked  
Password: thuang  
Email: thuang@intellisoftgroup.com

2. Select menu System -> Painter -> User Painter. The User Painter configuration window is displayed. Click Email Properties to display the Email Account maintenance window where you can manage and maintain the account settings for all users.
Intellisoft/Email send
Intellisoft/Email send
Email Send
Functionality

Send emails.
Operations

Send emails directly. Send emails from the contract. Send emails from the practitioner.
# Common troubleshooting tips

<table>
<thead>
<tr>
<th>Error code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>An exception has occurred.</td>
</tr>
<tr>
<td>3</td>
<td>The process has run out of memory.</td>
</tr>
<tr>
<td>4</td>
<td>An error has occurred due to a problem with the message body or attachments.</td>
</tr>
<tr>
<td>5</td>
<td>There was a problem initiating the conversation with the mail server. Ensure the setting of the Domain property is correct.</td>
</tr>
<tr>
<td>7</td>
<td>The from address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP mail servers will only accept mail from particular addresses or domains. SMTP mail servers may also reject a from address if the server can not successfully do a reverse lookup on the from address.</td>
</tr>
<tr>
<td>8</td>
<td>An error was reported in response to a recipient address. The SMTP server may refuse to handle mail for unknown recipients.</td>
</tr>
<tr>
<td>9</td>
<td>There was an error connecting to the SMTP mail server.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
</tr>
<tr>
<td>10</td>
<td>There was an error opening a file. If you have specified file attachments, ensure that they exist and that you have access to them.</td>
</tr>
<tr>
<td>11</td>
<td>There was an error reading a file. If you have specified file attachments, ensure that they exist and that you have access to them.</td>
</tr>
<tr>
<td>15</td>
<td>No mail server specified.</td>
</tr>
<tr>
<td>16</td>
<td>There was a problem with the connection and a socket error occurred.</td>
</tr>
<tr>
<td>17</td>
<td>Could not resolve host.</td>
</tr>
<tr>
<td>18</td>
<td>Connected but the server sent back bad response.</td>
</tr>
<tr>
<td>20</td>
<td>Cancelled as a result of calling the Cancel() method.</td>
</tr>
<tr>
<td>21</td>
<td>The operation timed out while the host was being resolved.</td>
</tr>
<tr>
<td>22</td>
<td>The operation timed out while connecting.</td>
</tr>
<tr>
<td>24</td>
<td>ESMTP Authentication failed.</td>
</tr>
<tr>
<td>Code</td>
<td>Error Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
</tr>
<tr>
<td>25</td>
<td>The selected ESMTP Authentication mode is not supported by the server.</td>
</tr>
<tr>
<td>26</td>
<td>ESMTP Authentication protocol error.</td>
</tr>
<tr>
<td>27</td>
<td>Socket Timeout Error.</td>
</tr>
<tr>
<td>105</td>
<td>Invalid license key.</td>
</tr>
<tr>
<td>-1</td>
<td>The EMail account of addresser has not config.</td>
</tr>
<tr>
<td>-11</td>
<td>Email Account cannot be null.</td>
</tr>
<tr>
<td>-12</td>
<td>Email Password cannot be null.</td>
</tr>
<tr>
<td>-13</td>
<td>Email Address cannot be null.</td>
</tr>
<tr>
<td>-14</td>
<td>SMTP Server address cannot be null.</td>
</tr>
<tr>
<td>-15</td>
<td>SMTP Server port cannot be null.</td>
</tr>
<tr>
<td>-16</td>
<td>SMTP Server Secure Password Authentication cannot be null.</td>
</tr>
</tbody>
</table>
Intellisoft/Email send/ Send emails directly
Intellisoft/Email send/ Send emails directly
Send emails directly
Send emails directly

1. Select menu System -> New Mail Message. The New Mail Message window displays, as shown below.
2. Input relevant information and the email body.
3. Click the Send button to send emails.
Intellisoft/ Email send/ Send emails from contract
IntelliSoft/ Email send/ Send emails from contract
Send emails from contract
Send emails from contract

2. Select the Email menu to open the Email window, as shown below.
3. In the Email window, select Email Template; select contacts from IC Contacts or Outlook Contacts; select attachments from files; or select attachments from Document Library or Document Manager.
4. Input relevant information and the email body.
5. Click the Send button to send emails.
Intellisoft/ Email send/ Send emails from practitioner
Send emails from practitioner
Send emails from practitioner

1. Select menu File -> Practitioner. The Practitioner window displays.
2. Click the Image tab, select an image to send, and click the Email menu. The Email window displays, as shown below.
3. Input relevant information and the email body.
4. Click the Send button to send emails. The image will be sent as an attachment.
Troubleshooting

If you encounter any of the common installation problems, you may be able to resolve the issue by following the steps indicated for that issue..

Contents

IE Security Set problems
ActiveX controls(OCX) problems
Email problems
Intellisoft/Troubleshooting/ IE Security Set
Intellisoft/Troubleshooting/ IE Security Set
IE security level set
Symptoms

Appeon Xcelerator plug-in cannot be loaded
Cause

This issue occurs if ActiveX controls are prevented from running on your computer. ActiveX controls may not run for one or both the following reasons:

1. Microsoft Internet Explorer may be configured to block ActiveX controls from running.
2. A firewall or a proxy server that exists between your computer and the Live Meeting conference center may be configured to block ActiveX controls.
Resolution

To resolve this issue, enable ActiveX controls in Internet Explorer. To do this, follow these steps:

1. Start Internet Explorer.
2. On the Tools menu, click Internet Options.
3. In the Internet Options dialog box, click the Security tab, and then click Internet
4. Under Security level for this zone, click Custom Level.
5. Under ActiveX controls and plug-ins, set all the following options:
   - Download signed ActiveX controls Enable or Prompt
   - Run ActiveX controls and plug-ins Enable or Prompt
   - Script ActiveX controls marked safe for scripting Enable or Prompt
6. Click OK, click Yes, and then click OK.

Note:
If you still receive the error message that is mentioned in the "Symptoms" section after you follow these steps, it is likely that a firewall or a proxy server that exists between your computer and the Live Meeting conference center is blocking the ActiveX controls. In this scenario, request that your Information Technology (IT) department stop blocking ActiveX controls to your computer or that your IT department add *.placeware.com to the list of trusted domains in the firewall or proxy server configuration.
ActiveX controls (OCX) registering failed

Symptoms
Failed to register OCX!
Exception occurred when invoking the dllregisterserver function.
Error: '%1S%' cannot be registered. Please click the Help icon to view the possible cause and solution.

Cause

. One or more of the necessary OLE DLLs is not in the path.
. The control is loading a DLL other than the OLE DLL, and that DLL is not in the path.
. The login user on this machine has no write permission to the download directory. Download failed.
. The login user on this machine has no rights to write the register. Registering failed.
. Registering OCX in Vista failed.
. One or more DLLs may be the wrong version.

Resolution

To resolve this issue, follow these steps:
1. Verify that the following files are in the following directory:

   imageviewer2.ocx
   imagethumbnailcp.ocx
   officecontrol.ocx
   scanner.ocx
   emsmtp.dll

   - If you are using Windows application, please check in the path which the application is installed.
   - If you are using Web application, please check in the path:
     %drive%:\Documents and Settings\%user_name%\Application
If these files exist, please register an ActiveX control (.ocx) manually, if error occurred, refer to the regsv32 error message.

if these files do not exist:

1. for Web development for J2EE platform

   Verify that those OCX files exist in Appeon Server, using the following way:
   
   http://X.X.X.X\%user_name%\plugin\emsmtp.dll
   
   If the filedown dialog displays, then files exist, otherwise, files do not exist.

2. for Web development for .NET platform

   Verify that those OCX files exist in Appeon Server, using the following way:
   
   http://X.X.X.X\%user_name%\plugin\emsmtp.dll
   
   If the filedown dialog displays, then files exist, otherwise, files do not exist.

3. If those OCX files exist in Appeon Server, please follow step 2 to check.

2. Verify that you logged on by using an account that has appropriate registry user rights.

1. If the login account does not have rights to write the register, please log in to Windows as the administrator.

2. Re-run the Web application. When the Intelli logon screen displays, close the Web application. Log off administrator from Windows. Log in to Windows as the normal user again (for example: use1).

3. If the problem still exists, please follow step 3 to check.

3. Verify that you logged on by using an account that has read and write rights for the special folder.

1. If you are using Windows application, verify that the login account has read and write rights to the folder: %drive%:\Program Files\intellicred.

2. If you are using Web application, verify that the login account has read and write rights to the folder: %drive%:\Documents and
Settings\%user_name%\Application Data\.
3. If the login account has no read and write rights, please assign it with the rights. For details, please refer to Windows help.
4. If the problem still exists, please follow step 4 to check.
4. If you are using the Vista OS,
   1. Please verify it’s a 32-bit OS. Registering will not succeed under 64-bit OS.
   2. Please verify User Account Control (UAC) is off. Take the following steps to turn it off:
      1. Click Start, type User in the Start Search box, and then click User Accounts in the Programs list.
      2. Click Turn User Account Control on or off.
         If you are prompted for an administrator password or for confirmation, type your password, or click Continue.
      3. Click to select the User Account Control (UAC) to help protect your computer check box, and then click OK.
         Note you may have to restart the computer to enable UAC.
   5. Contact support if the problem still exists after you follow the above steps.
Intellisoft/ Email send/ Error code 1
Intellisoft/ Email send/ Error code 1
Error code 1

Problem: Error Id= 1

An exception has occurred.

Solution:

- Check that the address and port of the SMTP server are valid.
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
Intellisoft/ Email send/ Error code 3
Intellisoft/ Email send/ Error code 3
Error code 3

Problem: Error Id= 3

The process has run out of memory.

Solution:

- Check that the email body and attachment are not oversize.
Intellisoft/ Email send/ Error code 4
Intellisoft/ Email send/ Error code 4
Error code 4

Problem: Error Id= 4

An error has occurred due to a problem with the message body or attachments.

Solution:

- Check that the disk where the mail folder resides has enough free space.
- When sending text, that if any line contains over 76 characters.
Error code 5

Problem: Error Id= 5

There was a problem initiating the conversation with the mail server. Ensure the setting of the Domain property is correct.

Solution:

- Check that the network is working correctly (use the ping command to test, for example, ping 192.0.0.9©
- Check that the address and port of the SMTP server are valid
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
- Check that DNS can be started correctly and that the domain name points to the correct address of SMTP server.
Intellisoft/ Email send/ Error code 7
Intellisoft/ Email send/ Error code 7
Error code 7

Problem: Error Id= 7

The From address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP mail servers will only accept mail from particular addresses or domains. SMTP mail servers may also reject a From address if the server cannot successfully do a reverse lookup on the From address.

Solution:

- Check that the from address is typed correctly and the format is correct
- Check the SMTP mail server configuration; ensure that it does not block emails from this particular address or domain.
Intellisoft/ Email send/ Error code 8
Intellisoft/ Email send/ Error code 8
Error code 8

Problem: Error Id= 8

An error was reported in response to a recipient address. The SMTP server may refuse to handle mail for unknown recipients.

Solution:

- Check that the recipient address is valid; ensure that it does not contain any unsupported non-Ascii characters.
Intellisoft/ Email send/ Error code 9
Error code 9

Problem: Error Id= 9

There was an error connecting to the SMTP mail server.

Solution:

- Check that the address and port of the SMTP server are valid.
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
Intellisoft/ Email send/ Error code 10
Intellisoft/ Email send/ Error code 10
Error code 10

Problem: Error Id= 10

There was an error opening a file. If you have specified file attachments, ensure that they exist and that you have access to them.

Solution:

- If you have specified file attachments, ensure that they exist and that you have access to them.
Intellisoft: Email send: Error code 11
Intellisoft/ Email send/ Error code 11
Error code 11

Problem: Error Id=11

There was an error reading a file. If you have specified file attachments, ensure that they exist and that you have access to them.

Solution:

- If you have specified file attachments, ensure that they exist and that you have access to them.
Intellisoft Email send Error code 15
Intellisoft/ Email send/ Error code 15
Error code 15

Problem: Error Id=15

No mail server specified.

Solution:

- No mail server specified. Please contact support.
Intellisoft/Email send/ Error code 16
Intellisoft/Email send/ Error code 16
Error code 16

Problem: Error Id=16

There was a problem with the connection and a socket error occurred.

Solution:

- Check that the SMTP server is started.
- Check that the address and port of the SMTP server are valid.
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
- Check that the sender’s email address is typed correctly and the format is correct.
Intellisoft/Email send/ Error code 17
Intellisoft Email send Error code 17
Error code 17

Problem: Error Id=17

Could not resolve host.

Solution:

- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that DNS can be started correctly and that the domain name points to the correct address of SMTP server.
Intellisoft/ Email send/ Error code 18
Intellisoft/ Email send/ Error code 18
Error code 18

Problem: Error Id=18

Connected but the server sent back bad response.

Solution:

- Check that the port is the SMTP port.
Intellisoft/ Email send/ Error code 20
Intellisoft/ Email send/ Error code 20
Error code 20

Problem: Error Id=20

Cancelled as a result of calling the Cancel() method.

Solution:

- Please contact support.
Intellisoft/ Email send/ Error code 21
Intellisoft / Email send / Error code 21
Error code 21

Problem: Error Id=21

The operation timed out while the host was being resolved.

Solution:

- Check that the network is working correctly (use the ping command to test, for example, ping 192.0.0.9)
- Check that the address and port of the SMTP server are valid
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
- Check that the email account settings are correct: SMTP server, Port, Account, Password, and Email.
Intellisoft/Email send/ Error code 22
Error code 22

Problem: Error Id=22

The operation timed out while connecting.

Solution:

- Check that the network is working correctly (use the ping command to test, for example, ping 192.0.0.9)
- Check that the address and port of the SMTP server are valid
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
- Check that the email account settings are correct: SMTP server, Port, Account, Password, and Email.
Intellisoft/ Email send/ Error code 24
Intellisoft/ Email send/ Error code 24
Error code 24

Problem: Error Id=24

ESMTP Authentication failed.

Solution:

- Check that the mail account and password are correct.
Intellisoft/Email send/ Error code 25
Intellisoft/Email send/ Error code 25
Error code 25

Problem: Error Id=25

The selected ESMTP Authentication mode is not supported by the server.

Solution:

- The selected ESMTP Authentication mode is not supported by the server. Please contact support.
Intellisoft/Email send/ Error code 26
Intellisoft/Email send/ Error code 26
Error code 26

Problem: Error Id=26

ESMTP Authentication protocol error.

Solution:

- ESMTP Authentication protocol is not supported, Please contact support.
Intellisoft/ Email send/ **Error code 27**
Error code 27

Problem: Error Id= 27

Socket Timeout Error.

Solution:

- Check that the network is working correctly (use the ping command to test, for example, ping 192.0.0.9©)
- Check that the address and port of the SMTP server are valid
- Check that the server address is typed correctly and the format is correct. The server address is not in block list of any other software.
- Check that the port is opened (use the telnet command to test, for example, telnet 192.0.0.9 25) and that the virus scanner, proxy server, and firewall allow the port of SMTP protocol.
Intellisoft/Email send/\textbf{Error code 105}
Intellisoft/Email send/Error code 105
Error code 105

Problem: Error Id=105

Invalid license key.

Solution:

- Invalid license key. Please contact support.
Intellisoft/mail send/Error code -1
Intellisoft/mail send/Error code -1
Error code -1

Problem: Error Id= -1

The EMail account of addresser has not config.

Solution:

- Please check Email account of addresser is config correctly.
Intellisoft/Email send/ Error code -11
Intellisoft/Email send/ Error code -11
Error code -11

Problem: Error Id= -11

   Email Account cannot be null.

Solution:

- Please input the Email Account.
Intellisoft/Email send/ Error code -12
Intellisoft/Email send/ Error code -12
Error code -12

Problem: Error Id= -12

   Email Password cannot be null.

Solution:

   - Please input the Email Password.
Intellisoft/Email send/ Error code -13
Intellisoft/Email send/ Error code -13
Error code -13

Problem: Error Id= -13

Email Address cannot be null.

Solution:

- Please input the Email Address.
Intellisoft/Email send/ Error code -14
Intellisoft/Email send/ Error code -14
Error code -14

Problem: Error Id= -14

SMTP Server address cannot be null.

Solution:

- Please input the SMTP Server address.
Intellisoft/Email send/ Error code -15
Intellisoft/Email send/ Error code -15
Error code -15

Problem: Error Id= -15

SMTP Server port cannot be null.

Solution:

- Please input the SMTP server port.
Intellisoft/Email send/ Error code -16
Intellisoft/Email send/ Error code -16
Error code -16

Problem: Error Id= -16

SMTP Server Secure Password Authentication cannot be null.

Solution:

- SMTP Server Secure Password Authentication cannot be null. Please contact support.
User Account Control

User Account Control (UAC) is a new feature that helps prevent malicious programs, also known as "malware," from damaging a system. UAC stops the automatic installation of unauthorized applications. UAC also prevents unintended changes to system settings.

You receive a UAC prompt when you do any of the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Install or uninstall a program.</td>
</tr>
<tr>
<td>.</td>
<td>Install a driver for a device. (For example, you install the driver for a digital camera.)</td>
</tr>
<tr>
<td>.</td>
<td>Use the Windows Update console to install updates.</td>
</tr>
<tr>
<td>.</td>
<td>Configure Parental Controls.</td>
</tr>
<tr>
<td>.</td>
<td><strong>Install an ActiveX control. (ActiveX controls are used to view certain Web pages.)</strong></td>
</tr>
<tr>
<td>.</td>
<td>Open or change the Windows Firewall control settings.</td>
</tr>
<tr>
<td>.</td>
<td>Change a user account type.</td>
</tr>
<tr>
<td>.</td>
<td>Modify your security settings with the Security Policy Editor (Secpol.msc) snap-in.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>.</td>
<td>Browse another user's directory.</td>
</tr>
<tr>
<td>.</td>
<td>Configure Automatic Updates.</td>
</tr>
<tr>
<td>.</td>
<td>Restore system files that were backed up.</td>
</tr>
<tr>
<td>.</td>
<td>Schedule Automated Tasks.</td>
</tr>
<tr>
<td>.</td>
<td>Copy or move files into the Program Files directory or the Windows directory.</td>
</tr>
<tr>
<td>.</td>
<td>Add or remove a user account.</td>
</tr>
<tr>
<td>.</td>
<td>Configure Remote Desktop access.</td>
</tr>
</tbody>
</table>
ActiveX controls(OCX) registering failed

**Symptoms**
OCX Registering failed!
Exception happened when invoking the DllRegisterServer function.
There was an error while registering OCX '%1S%'

**Cause**

. One or more of the necessary OLE DLLs is not in the path.
. The control is loading a DLL other than the OLE DLL, and that DLL is not in the path.
. The login user on this machine has no write permission to the download directory. Download failed.
. The login user on this machine has no rights to write the register. Registering failed.
. Registering OCX in Vista failed.
. One or more DLLs may be the wrong version.

**Resolution**

To resolve this issue, follow these steps:
1. Verify that the following files are in the following directory:

   ```plaintext
   imageviewer2.ocx
   imagethumbnailcp.ocx
   officecontrol.ocx
   scanner.ocx
   emsmtpl.dll
   ```

   - If you are using Windows application, please check in the path which the application is installed.
   - If you are using Web application, please check in the path:
     ```plaintext
     %drive%:\Documents and Settings\%user_name%\Application Data\.
     ```
- If these files exist, please register an ActiveX control (.ocx) manually, if error occurred, refer to the regsv32 error message.
- If these files do not exist:
  1. for Web development for J2EE platform

      Verify that those OCX files exist in Appeon Server, using the following way:
      http://X.X.X.X\%user_name%\plugin\emsmtp.dll
      If the filedownd dialog displays, then files exist, otherwise, files do not exist.

  2. for Web development for .NET platform

      Verify that those OCX files exist in Appeon Server, using the following way:
      http://X.X.X.X\%user_name%\plugin\emsmtp.dll
      If the filedownd dialog displays, then files exist, otherwise, files do not exist.

  3. If those OCX files exist in Appeon Server, please follow step 2 to check.

2. Verify that you logged on by using an account that has appropriate registry user rights.
   1. If the login account does not have rights to write the register, please log in to Windows as the administrator.
   2. Re-run the Web application. When the Intelli logon screen displays, close the Web application. Log off administrator from Windows. Log in to Windows as the normal user again (for example: use1).
   3. If the problem still exists, please follow step 3 to check.

3. Verify that you logged on by using an account that has read and write rights for the special folder.
   1. If you are using Windows application, verify that the login account has read and write rights to the folder: %drive%:\Program Files\intellicred.
   2. If you are using Web application, verify that the login account has read and write rights to the folder: %drive%:\Documents and Settings\%user_name%\Application Data\.
3. If the login account has no read and write rights, please assign it with the rights. For details, please refer to Windows help.
4. If the problem still exists, please follow step 4 to check.
4. If you are using the Vista OS,
   1. Please verify it’s a 32-bit OS. Registering will not succeed under 64-bit OS.
   2. Please verify User Account Control (UAC) is off. Take the following steps to turn it off:
      1. Click Start, type User in the Start Search box, and then click User Accounts in the Programs list.
      2. Click Turn User Account Control on or off. If you are prompted for an administrator password or for confirmation, type your password, or click Continue.
      3. Click to select the User Account Control (UAC) to help protect your computer check box, and then click OK.
         Note you may have to restart the computer to enable UAC.
   5. Contact support if the problem still exists after you follow the above steps.